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B crocte- 1

In-Text

Tick (V) the correct statement and cross (X) the
incorrect one.

(a) Don't disable your security software because you
feel it is slowing down your computer.v’

(b) Computers will have digital senses—speech sight
smell, hearing-enabling them to communicate
with human and other machines.v/

(¢) Any computer cannot be infected by malware. X

Exercise
A. Answer the following questions:

1. The Internet is a huge network of computers
around the world. These computers can be stand-
alone systems or local area networks that can be
connected to the World Wide Web through
telephone lines, TVs, satellite phones, etc. Nobody
is the sole owner of the Internet. Therefore, no one
is responsible for wrong information available on
the Net. It is a joint venture and, therefore, all the
Internet users need to take precautions for using
the information available on the Net.

The World Wide Web is one of the services
available on the Net which displays documents
presented by the other Internet users.

2. Most of the information that you will access
through the Net is stored on computers that are
known as servers. A server stores information for
use by clients. A client is a computer or a computer
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program which knows how to communicate with a
particular type of a server.

3. A website means a particular web server or a part
of a web server where information is stored. When
we use a web browser to contact a website, the
information on the server is displayed over the
screen. This information on your screen is termed
as aweb page.

The term 'home page' has two meanings. First, it
is a web page that your browser opens
automatically on your screen. For example, the
Internet Explorer can take you to the starting
page on the web server of Microsoft. After that, a
home page also describes the first of the web pages
put up by an organization on the Internet. When
you visit different websites, you will first get the
home page of every website and then other pages
linked to it can be seen.

Hyperlink or link is an object in the web page
which can be clicked to jump to another page or
another part of the same page of a website.

4. The abbreviation of Electronic Mail is E-mail. Itis
a service provided on the Internet for sending and
receiving documents or mails because this mail is
transferred electronically, so it takes no time to
reach the destination. There is no extra
expenditure even when it is being transferred
from one end to another end of the world.

5. To use the Internet, you need to get connected to
the Internet through a telephone line or cable. The
first step will be to switch on the computer and
then the external modem (if internal modem is
being used, it is turned ON automatically along
with the computer). After that, double click on the
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icon for your ISP on the desktop. As a result, a
dialog box with the connect button will appear
over the screen. Click on the connect button and
wait for dialing to ISP and get connected to the
Internet. You may need to make several attempts
for this connection depending on the data traffic
on the Internet and telephone lines. When you get
connected to the Internet, you can see a set of two
computers as an icon on the right most part of the
taskbar.

. Surfing the web means searching and visiting a
website for information which you require.

. Most anti-virus programs work like the human
immune system by scanning your computer for the
signatures (patterns) of digital pathogens and
infections. They refer to a dictionary of known
malware, and if something in a file matches a
pattern in the dictionary, the anti-virus software
attempts to neutralize it. Like the human immune
system, the dictionary approach requires updates,
like flu shots, to provide protection against new
strains of malware.

. In this approach, instead of attempting to identify
known malware, an anti-virus software monitors
the behaviour of software installed on your
computer. When a program acts suspiciously,
such as trying to access a protected file or to
modify another program, the anti-virus software
spots the suspicious activity and alerts you about
it. This approach provides protection against
brand new types of malware that do not yet exist
in any dictionary.

. Recent technological advances in computing,
communications, software and hardware have
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enabled the significant growth of cyberspace, an
important aspect of modern life that continues to
transform the way citizens, businesses and
governments interact, collaborate and conduct
business. Our heavy dependence on various
digital infrastructures has made them strategic
national assets that must be protected to ensure
economic growth, prosperity and safety in the
future.

10.Cloud computing has emerged as a dominant

paradigm, widely adopted by enterprises. Clouds
provide on-demand access to computing utilities,
an abstraction of unlimited computing resources
and support for on-demand scale-up, scale-down,
and scale-out. Cloud platforms are also rapidly
becoming viable for scientific exploration and
discovery, as well as education.

B. Write T for the True statements and F for the
False ones:

1.T 2.T 3.T 4T 5. F
C.Fillin the blank with an appropriate word:

1.

© =N o

net 2.  important

tools 4. fast

clients 6. communication
protocols 8. Internet
website 10. HTTP

11. world wide web 12. E-mail

D. Write short notes on the following:

a.

TCP/IP—There are two protocols which are used
for working with the Internet. These are known
as Internet Protocol (IP) and Transmission
Control Protocol (TCP). Nowadays, each network



and computer system on the Internet has a
unique numeric address, known as the IP address
that also has a corresponding name. When
information is passed from one computer to
another, the TCP breaks it into small packets.
Each packet has the IP address of the sender and
the recipient. The Internet Protocol finds the
convenient route for each packet on the Internet.
At the destination, the TCP reassembles the
packets into complete information.

b. HTTP— The World Wide Web protocol is known
as HyperText Transfer Protocol or HTTP. The
documents passed from servers to clients are in
hypertext format.

c. URL— URL stands for Uniform Resource Locator
and it is a universal address of the documents and
other resources on the World Wide Web.

d. Domain name— Domain name is the name of
website

e. Virus and Anti-virus— Any computer can be
infected by malware. Malware is a catch-all term
for malicious programs, such as viruses, worms,
trojans and spyware, which are designed to infect
and take control of your computer. Once your
computer has been infected, malware can capture
all your keystrokes, steal your documents and use
your computer to attack other computers. Anti
virus software is designed to protect your
computer against malware. It is available as a
stand-alone product and is also included in most
security software packages.

f. Anti-virus tips—

1. Don't Assume You're Not At Risk



Every computer, regardless of its operating
system, is vulnerable to attack. While anti-virus
programs cannot protect against all types of
malware, the security of your computer is
enhanced substantially when an anti-virus
software is installed, up to date, and working
properly.

2. Download Only From Trusted Sources
Obtain security software only from known,
trusted sources and vendors. It is a common play
of cyber criminals who pretend to sell anti-virus
programs that are, in fact malware.

3. Keep Your Software Current

Make sure that you have the latest version of your
anti-virus product installed and that it is set to
update automatically. Check the status of the
signature updates periodically to make sure they
are current.

4. Don't Delay Updates

If your computer has been offline or powered off
for a while, your anti-virus software will most
likely need an update when you turn it back on or
reconnect it to the Internet. Do not postpone these
updates.

5. Scan Additional Devices

Make sure your anti-virus software automatically
scans portable devices, such as USB sticks, when
you plug them into your computer.

6. Track Warnings And Alerts

Pay attention to the onscreen warnings and alerts
generated by your anti-virus software. Most alerts
include the option of clicking on a link to get more
information or a recommendation about what to
do next. At the office, write down the alert
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messages and contact your computer help desk or
security team.
7.Don't Disable the Software
Do not disable your security software because you
feel it is slowing down your computer, blocking a
website, or preventing you from installing an app
or a program. Disabling your anti-virus program
will expose your computer to unnecessary risk
and could result in a serious security incident. If
problems persist, replace your anti virus software
with another product.
8. Install One Program Only
Do not install multiple anti-virus programs on
your computer at the same time. Doing so may
leave your computer with less protection instead
of providing more protection.

g. Latest trends in computer technology— Here
are top 10 trends of the 21st century computers:

* Computers will become powerful extensions of
human beings designed to augment intelli-
gence, learning, communications and produc-
tivity.

* Computers will become intuitive — they will
"learn," "recognize," and "know" what we
want, who we are, and even what we desire.

* Computer chips will be everywhere, and they
will become invisible-embedded in everything
from brains and hearts, to clothes and toys.

* Computers will manage essential global
systems, such as transport and food produc-
tion, better than humans will.

* Online computer resources will enable us to
download applications on-demand via
wireless access anywhere and any time.



* Computers will become voice-activated,
networked, video-enabled and connected
together over the Net, linked with one another
and humans.

* Computers will have digital senses-speech,
sight, smell, hearing-enabling them to
communicate with humans and other
machines.

* Neural networks and other forms of artificial
intelligence will make computers both as
smart as humans, and smarter for certain
jobs.

* Human and computer evolution will converge.
Syntheticintelligence will greatly enhance the
next generations of humans.

* Ascomputers surpass humansin intelligence,
a new digital species and a new culture will
evolve that is parallel to ours.

h. Future technology— Computers are deciding
which products to stock on shelves, performing
legal discovery and even winning game shows.
They will soon be driving our cars and making
medical diagnostics. Here are five trends that
are drivingit all.

1. No-Touch Interface

The basic pattern of recognition technology has
been advancing for generations and, we can expect
computer interfaces to become almost indistin-
guishable from humans in little more than a
decade.

2. Native Content

While over the past several years, technology has
become more local, social and mobile, the new
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digital battlefield will be fought in the living room,
with Netflix, Amazon, Microsoft, Google, Apple
and the cable companies all vying to produce a
dominant model for delivering entertainment for
consumers.

3. Massively Online

In the last decade, massively multiplayer online
games, such as World of Warcraft became all the
rage.

4. The Web of Things

Probably the most pervasive trend is the Web of
Things, where just about everything we interact.
Our homes, our cars and even objects on the street
will interact with our smartphones and with one
another, seamlessly.

5. Consumer-Driven Supercomputing
Everybody knows the frustration of calling to a
customer service line and having to deal with an
automated interface. It works well enough, but it
takes some effort. After repeating yourself a few
times, you find yourself wishing that you can just
punch your answers in or talk to someone at one of
those offshore centres with heavy accents.

These systems will know us better than our best
friends, but will also be connected to the entire
Web of Things as well as the collective sum of all
human knowledge.

HOTS
Doit yourself

Multiple Choice Question
E.Tick (v) the correct options:
l.a 2.a 3.b 4.a 5.a
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Project

Doit yourself
In-Text

Put a tick (V) for each of the correct statements
and a cross (X) for each of the incorrect ones.

(a) PowerPoint helps you to structure the ideas and
information that you want to convey to your
audience. v

(b) Themes are design templets that can be applied to
an entire presentation which allows for consis-
tency throughout the presentation. v/

(c) Layout refers to the way things are arranged on a
slide. v/

Exercise

A. Answer the following questions:

1. MS PowerPoint is a presentation software. It
is a part of Microsoft Office package. It is used
for creating professional quality audio-video
presentations.

2. A presentation consists of a number of slides.
These slides are grouped together in a
sequence to form aslide show. Aslide show is
an electronic presentation displayed on a
computer screen.

3. The ribbon replaces menus, toolbars and most of
the task panes that were found in PowerPoint
2003. The ribbon is located at the top of the
document window and consists of tabs that are
organized by tasks.

4. PowerPoint 2007 provides you with two types of
tabs on the Ribbon. The first type are called



ot

o2}

standard tabs, which are the default tabs that
appear when you start Microsoft PowerPoint.
They include Home, Insert, Design, Animations,
Slide Show, Review, View and Add-Ins (optional).
The second type are called contextual tabs, such
as Picture Tools, Drawing, or Table that appear
only when you perform a certain task.
PowerPoint 2007 provides you with the right set
of contextual tabs while performing certain tasks.
Some groups within PowerPoint 2007 have a
Dialog Box Launcher that is located on the
bottom right-hand corner of each group. Clicking
on the Dialog Box Launcher will open dialog
boxes or task panes that will allow you to modify
the current settings.

They allow you to zoom in or out using the slide or
the buttons.

Themes are design templates that can be applied
to an entire presentation which allows consis-
tency throughout the presentation.

PowerPoint provides you with a powerful spell-
checker that works in the same fashion as the one
in Microsoft Word.

It's always a good idea to use a spell checker and
proofread your presentation yourself, however,
the spellchecker can sometimes be a lifesaver.

To check an entire presentation, don't select any
text. If you run the spellchecker with a specific
text selected, it will only check that text. You don't
have to click on the insertion point at the
beginning of a presentation to begin spellcheck-
ing, as the spellchecker will wrap around until it
has checked the entire presentation.

9. Animation of text in PowerPoint refers to the



manner in which individual text or other objects
appear as they enter or exit a slide. Normally, all
objects on a slide appear at the same time when
you display the slide. However, you can make
different objects appear and exit at different times
under your control as the slide show proceeds.

10. For each slide in a presentation, you can set a
different transition effect and determine how fast
the transition will happen.

To set transition effects:

1. Switch to Slide Sorter view.

2. Select the slides to which you want to assign a
transition.

3. Choose the Animation button on the ribbon to
open the Slide Transition task pane.

4. From the Apply to Selected Slides list box, select
the transition effect you want to apply.
PowerPoint previews the effect on the selected
slides and displays a Preview Animation button
beneath each selected slide.

5. In the Modify Transition section, select a speed
(Slow, Medium, or Fast) for the transition
effect. Once again, PowerPoint previews the
effect on the selected slides.

6. To preview the effect again, click on Animation
Preview button beneath the slide on the left
side.

7. Close the Slide Transition pane.

B. Write T for True statements and F for False
ones:

1.T 2.T 3.T 4.T
C. Fill in the blank with an appropriate
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word:

1. presentation 2. idea 3. top
4. two 5. available

HOTS

Doit yourself

Multiple Choice Question
D. Choose the correct options:

l.a 2.b 3.c 4.a 5.a
6.a 7.c 8.b 9.c
Activity Time
Doit yourself
B Choote-> N
In-Text

Put a tick (v) on each of the correct
sentences and a cross (X) on each of the
incorrect ones.

(a) dJoystickis apointingdevice.v

(b) Light pen consists of a photocell and an

optical system placed in a small tape.v’

(c) OMRisused toinput music. X
Exercise
A. Answer the following questions:

1. Word provides an amazing range of tools to help
you create professional-looking documents.

Characteristics that affect the appearance of one
or more characters are called character formats.

2. The style of typeface that you use is called the font
and there are literally hundreds to choose from.

To change your font:

a. First, select the relevant text. This can be
anything from a single character to the entire



d.

e.

document.
Find the Font field on the Home ribbon.

Click on the drop-down arrow next to the Font
field.

You'll see a list with a number of font choices.
Scroll through the list until you've found the
font that you want to use. As you move the
mouse over a particular font, your text will
show how that font would look like. This is
called Live Preview.

Select the desired font by clicking on its name.

3. It is easy to change your text into bold, italic or
underlined. As usual, you can start by selecting
the text that you want to format; otherwise, Word
will not know where the new formatting should be
applied.

a.
b.

Select the relevant portion of your text.

Click on the appropriate character formatting
button on the Home ribbon.

for Bold
for Italic
for Underline

The arrow next to the underline button offers
you a choice of underlining styles.

To turn a character format OFF, click on the
same button again.

You can select multiple formatting

characteristics at the same time, for example,
by clicking on Bold and then Italic.

4. Paragraph formatting applies to a complete
paragraph, that is, all the text between two
occurrences of ENTER. And you don't even need to
select the text first, unless you want to format
more than one paragraph. Just position your
cursor anywhere inside the paragraph that you



want to format,i.e.,

Right, left, or in the middle.

By default, paragraphs are usually left-aligned:
the left margin is straight, but the right margin is
jagged (like in this page). Word provides you with
a number of other options though. Just position
your cursor anywhere in the paragraph, and click
on one of the text alignment buttons on the Home
ribbon.

. Here's how you can create a bulleted list.

a. First, type the points that you want to bullet,
one under another. Make sure you create them
as individual paragraphs by pressing ENTER
after typing each point.

b. Select the paragraphs that you'd like to use
bullets on.

c. Click on the Bullets button in the Paragraph
section of the Home ribbon.

d. You can see that the selected paragraphs have
been formatted as bulleted points.

The drop-down arrow on the right of the Bullets
button allows you to choose from different
bullet styles.

. Line spacing options

Single Default option - This option sets line
spacing to one line.

1.5 lines — This option is one and a half times that
of single line spacing.

Double — This option is twice that of single line
spacing.

At least — This option sets a minimum amount of
space between lines.



Exactly — This option sets fixed line spacing,
expressed in points.

Multiple — This sets the line spacing to accommo-
date multiple lines.

7. There are five types of tab stops available which do
the following:

Left-aligned — Text flows to the right.

Centered — Text centres on this position as you
type.
Right-aligned — Text flows to the left.

Decimal-aligned — Text aligns on the decimal
point while using numbers.

Bar — Inserts a vertical line at tab stop Setting
tabs using the ruler. This is the easiest way to set
tabs.

8. Adding text to your table is very easy. This is how
you candoit.

a. After you've created the table, the cursor will be
blinking in the first cell. You can begin typing
here.

b. To move on to the next cell, just press the TAB
key.

c. When you want to move to the next line, just
press TAB again. Don't press ENTER. It will
create a new line inside the current cell.

If you've reached the end of the table and you
need another row, press the TAB key and a row
will automatically be added into the table.

9. Ifyou like to delete a row or a column, here's how
you can doit:

a. Position the cursor in the row or column that
you want to get rid of.



b. Click on Layout ribbon tab.

c. Click on the Delete button and a drop-down
menu will appear.

d. Select an option to delete cells, columns, rows
or even the entire table.

10.a. Click on the point in your document where
you'd like to add a Clip Art graphic.

b. Click on Insertribbon tab.
c. Clickon Clip Art button.

d. A Clip Art pane will open on the right of your
document.

e. Type a descriptive term in the Search For
field, for example, sport. Then click on Go or
press ENTER.

f. The Clip Art Gallery will show you all the
available graphics related to this theme.

g. Clicking on a picture will insert it in your
document.

B. Fill up each blank with an appropriate word:

1. appear 2. professional
3. font 4. underlining
5. new 6. bullet

Multiple Choice Question

D. Tick (v') the correct options:
l.a 2.c 3.a 4.b
HOTS
Doit yourself
Activity Time
Doit yourself

B Crocte -

In-Text

Tick (v) the correct statements and cross (X) the
incorrect ones.




(a) To start Excel, click on the Start button on the
desktop and then on All Programs and click on
Excelin the list of programs. v’

(b) When you move the mouse pointer in the work
area, it changes from the shape of an arrow to a
minus sign. X

(c) We should start the formula with the =sign. v/
Exercise
A. Answer the following questions:

1. A spreadsheet is a program that provides a table
to put the data in rows and columns. After putting
the data, we may compute them by using formula
and find the result in any desired cell.

An electronic spreadsheet has rows and columns
and the intersection of a row and column is called
a cell. A cell may contain numbers, text or a
formula that tells us about its relations with the
value of other cells. If you change the value of any
cell in the entire worksheet, the result related to it
is also changed in the same way.

2. When you move the mouse pointer in the work
area, it changes from the shape of an arrow to a
plus sign. Now, you may choose a cell where you
want to input the data. Click on the cell of your
choice.

If you want to change from one cell to another, you
may use the concerned arrow keys.

3. Before working with a worksheet, you should
know how to select the cells. You may select a
group of cells (range) in the following way.

Left click on the button of your mouse and drag it

over the selection. Now, click on one cell and hold
down the shift key and drag the cursor to the
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opposite corner of the selected area.

4. When you are working in a worksheet, you may
copy the contents of the cell from one place to
another. For doing this, first select the cell by
clicking the left mouse button at the starting
point and then drag your mouse over the entire
area that you want to copy. Now, go to Edit menu
and select copy or click on the copy icon. After
this, click on the cell area where you want to place
the contents. Again, go to Edit menu, select Paste
and click on the Paste icon.

5. The worksheet may be printed by using the Print
command over the File menu. You may also print
it by using the print icon on the toolbar. Here, the
entire worksheet is very large and you have only
entered data on a very small portion of it, so if you
give the print command without specifying the
area which has to be printed, most of the pages
will be blank. Before printing a worksheet, the
area that has to be printed must be specified.

To set the print area, drag your mouse over the
cells that you want to print. On the File menu,
select Set Print Area. A dotted line surrounds the
selected cells on the worksheet. Now select Print
from the File menu or click on the Print icon.
Thus, only the selected area of the worksheet will

get printed.
B. Fillin the blanks with appropriate word :
1. worksheet 2. file
3. file 4. MS office
5. filemenu 6. cells
7. editing
C. Tick (v) the correct statement and cross (X) the
incorrect one:
1./ 2.V 3.V 4./
5V
HOTS
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Doit yourself

Project
Doit yourself
Activity Time
Complete the crossword:
DIA|T|A
\W|O|R|K|S|H|E|E|T]

X

C|

E|

L

PIR|O|G|R|A|M

B crocte -5

In-Text
Tick (v) the correct statements and a cross (X) for
each of the incorrect ones.
(a) Tim Berners Lee at CERN designed the original
HTML document type in year 1990.v/

(b)HTML consists of standerdised codes that are
used for defining the structure of information on a
web page.v/

(c) The body part of the HTML document contains all
other elements except the HEAD element.v/
Exercise
A. Answer the following questions.

1. The Hypertext Markup Language is a developed
form of Standard Generalized Markup Language
(SGML). Tim Berners Lee at CERN designed the
original HTML document type in the year 1990.
After this in 1992, Dan Connolly wrote the HTML
document type and a brief HTML specification.



Since 1993, a number of people have contributed
to the evolution of the HTML. In the year 1994,
Dan Connolly and Karen Olsen Muldrow rewrote
the HTML specification.

The HTML document may be displayed on the
host computer at any distant location. It is a
versatile language which can be used on any
Windows or other platform. Being platform
independent, HTML indicates the way in which
the document is to be read by the interpreter. This
is done by a set of HTML elements, that mark up
the document and inform the browser about the
action which has to be taken.

Web page is a document page on the computer
which has a set of information containing text,
pictures, links and other elements. HTML
consists of standardised codes (tags) that are used
for defining the structure of information on a web
page. These codes enable you to have several
features, like making the text bold, italics,
putting headings, paragraph breaks, numbered
or bullet list, images, hypertext links, etc.

HTML uses a descriptive markup to define the
structure of a text area. There are different tags
which are used for defining a document area
which has certain characteristics. These tags are
called HTML elements. The structure of an
HTML document is very simple. HTML helps us
todesign attractive web pages with less effort.

. There are many HTML elements that we use to
create an HTML file. The HTML element consists
of a less than sign (<) followed by the name of tag
and closed by a greater than sign (>).

The HTML elements may be classified in con-



tainer elements and empty elements. The
container elements are paired and have a starting
and ending tag. The ending tag is the same as that
of the starting tag except that the former has a
slash that precedes the text within less than and
greater than sign. For example, <HTML> ...
<HTML>. The empty elements are those which do
not have the end tag but only the starting tag. An
empty element takes the attributes which are
given within the angular brackets, along the tag
name. For example, <ISNDEX> and (LINK).

5. We use these attributes to set the color of the link
text in the document when the hyperlinks are
displayed. The LINK attribute is used for specify
the color. The default color is blue that appears
automatically. VLINK stands for Visited LINKS.
Its default color is purple but you may change it by
changing the value in this attribute. A LINK
stands for Active LINK and its default color is red
that can also be altered by changing the attribute.

6. There are certain elements which are used for text
block formatting in HTML document. All the
block formatting elements are placed inside the
body.

B. Define the following attributes.

a. SIZE attribute — The size attribute allows the
user to give a specific size for the font. The valid
value range is from 1 to 7 but the default size is 3.
You may add + or — sign to increase or decrease the
size from the base font of the document.

Example : <FONT SIZE = 4> changes the font size
to4>

</FONT>
b. COLOR attribute — The colour attribute changes
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the text colour which appears over the screen. The
colour may be set by giving the value as # ggrrbb,
a hexadecimal value. It may also be set by giving
the name of the colour supported by the browser.

Example: <FONT COLOR = "Blue">
</FONT>
. FACE attribute — By using face attribute, you
may select a typeface to use in the text. You may
use only that typeface which is available on your
computer.

Example: <FONTFACE ="ARIAL"></FONT>
When you use this font size, the characters
followed by this element will appear in Arial font.
. CLEAR attribute — We use this attribute with the
<BR> element. You may use it in several ways as
shown below :

(i) CLEAR = LEFT breaks the line and moves
down vertically until thereis a clear left margin.
(ii)) CLEAR = RIGHT breaks the line and moves
down vertically until there is a clear right
margin.

(iii) CLEAR = ALL breaks the line and moves
down until both the left and right margins are
clear.
. WIDTH attribute — The horizontal ruler by
default is made of the same width as the width of
the page width. This may be changed by using
width attribute with the HR element. The width
may be specified as a number of pixels or as a
percentage.
Example : <HR WIDTH = 30%>
This will make the horizontal rule 30% width of



the full width of the page.

f. ALLGN attribute

— We use the Align attribute

to determine the vertical or horizontal alignments
and placement of the image.

We use this attribute as mentioned below:

ALIGN =LEFT

ALIGN =RIGHT

ALIGN =TOP

: Sets the image against
the left margin and gets
placement on the left hand
side of the text.

: Sets the image against the

right margin and the text
remains on the left side of
theimage.

: By using Align attribute in

this way, the image is
aligned on top of the

page.

ALIGN = MIDDLE: It aligns the image in the

middle of the screen.

C. Write 'T' for the True statements and 'F' for the

False ones:

1.T 2.T
D. Fill up the blanks:
HTML
document
HTML
Web page

9. 1994
HOTS
Doit yourself

N oL =

3.F 4.F
2. color

4. element
6. HTML

8. location
10. 1990

Multiple Choice Question

E. Choose the correct options.



B crocter- s NN

l.a 2.¢c 3b 4a 5.b 6.c
Activity Time

Doit yourself
In-Text

Tick (V) the correct statements and cross (X) the
incorrect ones.
(a) LIST command is used for listing the
programs.v/
(b) SYSTEM command is used for closing the
system.X
(0 RME command is used for showing the
position of the mistake.v
Exercise
A. Answer the following questions.
1. Features of Qbasic
a. Itisauser-friendly language.
b. It is a widely known and accepted program-
ming language.
c. It is one of the most flexible languages as

modification can be done easily in already
existing program.

d. Language is easy since the variables can be
named easily and they use simple English
phrases with mathematical expressions.

2. a. All QBasic programs are made up of series of
statements, which are executed in the order in
which they are written.

b. Every statement should have at least one
QBasic command word. The words that
BASIC recognizes are called keywords.

c. All the command words have to be written
using some standard rules, which are called



"Syntax Rules". Syntax is the grammar of
writing the statement in a language. Syntax
errors are generated when improper syntax is
detected.
3. Data are a collection of facts and figures which are
entered into the computer through the keyboard.

4. Once QBASIC program is loaded into the
computer memory, OK prompt displays. Ok
means it is ready to accept the commands.
QBASIC can be made to translate your
instructions in two modes:

¢ Direct Mode ¢ Program Mode
5. a. CLS: This command is used for clearing the
screen.

b. PRINT: Print command is used for displaying
the output on the screen. E.g. Print "HELLO
WORLD!!!"

Print 80 * 8

Print — Only Print command will leave a blank
space.

Print Tab(10) "Prakriti" — will print Prakriti on
10 column.

c. REM: It stands for remark. It gives an explana-
tion of the program or of the statements in the
program thereby making the program more
understandable to the reader. The computer
does not execute this statement since whatever
is written after REM is ignored by the
compiler. REM can be used anywhere and
many times in a program.

B. Write 'T' for the True statements and 'F' for the
False ones:
1.T 2.T 3.T 4.T

C. Fill up the blanks:

1. Beginner's 2. programs 3. keywords



4. one 5. LET 6. $
7. OK
HOTS
Doit yourself
D. Describe the following in one line.

a. LIST - This command is used for listing the
program on the screen.

b. RUN - This command is used for executing the
program.

c. LPRINT - This command is used for getting the
output ofthe program on the hard copy.

d. NEW - This command is used for clearing the
memory of the existing program.

e. SYSTEM - This command is used for taking you
back to dos prompt.

f. SAVE - This keyword is used for saving the
program.

Multiple Choice Question
E. Choose the correct options:
l.a 2¢c 3¢ 4a 5bb 6.a 7b 8c
Project
Doit yourself

B crocte-7

In-Text

Tick (V) the true statements and cross (X) the false
ones.

(a) The loop will execute only once if the start and
end values areequal. v/

(b) If step is not given, then QBASIC assumes the



incrementtobe2. X
(c) When a set of instructions are repeatedly
executed, a fixed number of times, it is termed as
aloop. v
Exercise
A. Answer the following:

1. Command PRINT displays text or numbers on the
screen.

The program line looks like this:
PRINT "My nameis Utkarsh."

2. QBASIC also needs to keep words or numbers in
its memory. To do this, you use variables in
QBASIC memory, which can keep information. A
variable can be named with any letter, for
example :— ¢ It can also have a longer name, which
can be almost any word. It is important to know
that there are two main types of variables one that
keeps anumber and the other that keeps a word or
a string of words.

3. INPUT is a command that allows you or anybody
else who runs the program to enter the informa-
tion (text or number) when the program is already
running. This command waits for the user to enter
the information and then assigns this information
to a variable. Since there are two types of
variables, the INPUT command may look like this
— INPUT a (for a number), or INPUT a$ (for a
string).

4. Quite often you don't want the program to run
exactly in the order you put the lines, from the
first to the last.

Sometimes, you want the program to jump to a



particular line. For example, your program asks
the user to guess a particular number:

~ ~ ~ ~'some of the program here

INPUT "Guess the number"; n

~ ~ ~ ~some of the program there

The program then checks if the entered number is
correct. But if the user gives the wrong answer,
you may want to let him try again. So you use the
command GOTO, which moves the program back
to the line where the question is asked.

5. QBASIC can perform the following mathematical
operations:
Operator ~ Whatit does Example  Result
+ Add 7+2 9
- Subtract 7-2 5
g Multiply 7%2 14
/ Divide 7/2 3.5
Examples:
a. l.a=15/4+3
PRINT a
Result on the screen—6
b. PRINT "Enter the first number"

INPUT a

PRINT "Enter the second number"
INPUTD

c=a+b

d=a*b

PRINT a; "+"; b;"="; ¢

PRINT a; "*"; b;"=";d

END

When you run this program, it goes like this:



Computer: Enter the first number

You: 22

Computer: Enter the second number

You: 18

Computer: 22 + 18 =40

. In many programs (for example - games), the user
has a choice of what to enter. In this case, QBASIC
has to check what the user has typed and react
accordingly. This can be done with the

IF...THEN command.

IF... THEN...ELSE

This command checks if an argument involving a
variable is true. An argument may look like this:
IFa

= 15 THEN... If the argument is true (and a is
really equal to 15), then QBASIC executes the
command

you put after the IF.. THEN.

Example:

I[F a=15THEN PRINT "OK"

If the argument is not true (if a is not equal to 15),
QBASIC bypasses this line and goes to the next.

. When a set of instructions are repeatedly executed
afixed number of times, it is termed as loop.

To make interesting and efficient programs, you
can make QBASIC to execute a part of a program
more than once. This is called looping, when
QBASIC goes through a part of a program over
and over again.

This can be done with the GOTO command, but in
QBASIC there are some good ways to loop the
program. One of them is FOR...NEXT command.



While using counters, we have to follow the
following points:

a. Initialize the counter
b. Increase or Decrease the counter
¢. Check for the maximum limit

This process may become very tedious, if the
program is very long with several counters. In
that case, we use a loop and there are different
types ofloops like For-Next.

FOR..NEXT

This command allows you to execute a part of a
program a certain number of times. It looks like
this:

FORi=1TO4

PRINT "I am looping!"

NEXT

This little stupid program will print on the screen:
I am looping!

I am looping!

I am looping!

I am looping!

. LEN : Returns the length of the string.

Syntax : L= Len (string);

Where, L = the variable storing the number of
characters the string has.

String = the string whose length has to be found.
Example:

10cls

20 s$ ="Kalpana"

30m =len(s$)



40 print m
50 end

The above program would give output = 7, as even
spaceis considered as a character.

B. Write 'T' for the True statements and 'F' for the
False ones:

1.T 2.T 3.T 4T

5.F 6.T 7.T
C. Fill up the blanks:

1.emptyline 2.screen 3. letter 4.end

5% 6.once 7.good 8.blue

9.input 10. loop 11.1 12.end
B crocce - o I
In-text

Tick (v) the true statements and cross (X) the false
ones.

(a) Printing options have been reconfigured in
Office 2010. v

(b) The Backstage View, or File tab, replaces the
Office button, present in Office 2007. v

(c) Theribbonisarrangedin files. b 4
Exercise
A. Answer the following.

1. The application icon in the upper left corner of the
window contains commands to restore, minimize,
maximize and close the active window, much like
the commands located in the upper right corner.

The Backstage View, or File tab, replaces the
Office Button, present in Office 2007.



Familiar commands, such as Save, Save As, Open
and Close, are located near the top of the tab.

. Options for sending files via e-mail, publishing
them to the web using Windows Live, and saving
to a SharePoint site are located here. The Change
File Type option lists a variety of file types.
Starting the file saving process in this way is an
alternative to going directly to the traditional
Save As dialog box; yet, clicking on Save As button
located here launches the Save As dialog box as
well. This category is called Save & Publish in
Access 2010.

. The Help feature located in the Backstage View
provides links to Microsoft Office online tools,
along with tools to access application Options and
Check for Updates. Application Help may also be
accessed using the blue circle with the white
question mark in the upper-right corner of the
interface.

. The Ribbon is arranged in tabs. Each tab houses
categorized groups of application-specific
commands. Each application has a certain
number of default tabs and may show contextual
tabs with additional tools when certain elements
in the file are active. In Office 2010, the ribbon
can be minimized, as well as customized.

. Custom tabs and groups can be added to the
ribbon, commands can be added to custom groups
and the names of existing tabs and groups can be
changed. The tools to perform these processes are
found in the Customize Ribbon category in the
Application Options dialog box. The Application
Options dialog box can be accessed directly from
the Options command in the Backstage View/File



6.

tab list, in the Backstage list's Help category
under Tools for Working with Office. It can also be
found by right-clicking a Ribbon tab and selecting
Customize the Ribbon.

* Add and name a custom Ribbon tab

¢ Within the Application Options dialog box,
click on New Tab button.

o Select New Tab (Custom) in the list.
e (Click on Rename button.

e Type the new name and click on OK button in
the Rename dialog box.

e Click on OK button for Application Options
dialog box.

The Screenshot feature is located on the Insert tab
in Word, PowerPoint and Excel. This feature
captures screenshots from all open applications
and allows them to be selected and pasted into the
active file. The Screen Clipping command allows
the screenshot to be cropped as needed before
being pasted in the active file.

7. The Sparklines feature is found in the Sparklines

group of the Insert tab. Sparklines are small
charts in individual cells. They may be used to
summarize data and show trends. There are three
types of Sparklines: Line, Column and Win/Loss.
When the command is selected, a dialog box
appears to collect the Data Range to be used and
the Location Range where the mini charts will be
placed. When a Sparkline is inserted into a
worksheet, the Sparkline Tools Design contextual
tab appears on the ribbon to provide formatting
options.



8. Table, Datasheet, View, Fields Tab present under
the Table Tools contextual tab, contain tools to
create and format a table in Datasheet view. The
More Fields command provides an expanded list
of field templates, including Quick Start options
used for inserting individual and groups of fields
based on commonly used field categories. A
Calculated Field option inserts calculations into
the table based on field data type.

B. Write 'T' for the True statements and 'F' for the

False ones:
1.T 2.T 3.F 4.T 5T
6.T 7.T 8.T 9.7

C. Fill up the blanks:
1. office 2007 2.reconfigured 3. tools
4.0k 5. access 6.updates
Multiple Choice Questions
D. Choose the correct options:
l.a 2.b 3a 4b b.a

B chocte-o

In-text

Put a tick (V) for each of the correct statements
and a cross (X) for each of the incorrect ones.

(a) The imported files come up in the Collection
Pane in the Windows Movie Maker.v/

(b) Avideo effect decides how a video clip, picture or
title gets displayed in your project. v/

(c) Titles or credits allow you to add text, such as
the title of your movie, your name, date, etc.v/

Exercise



A. Answer the following questions:
1. To add video effects, take the following steps:
v Click on View Video Effects of the movie task.
v Now, video effects will appear in the collection
pane, e.g. Blur, Ease In and Ease Out.

v After that, drag a video effect and drop it on a
video clip of the Storyboard.

. It includes the following:

2

a. Show collections b. View video effects

c. Viewvideo transitions d. Make title or credits
3

. To add Video Transitions, follow the steps given

below:

v Click on View Video Transitions of the movie
tasks.

v Video transitions will appear in the collection
pane, e.g. Bars, Circle, Bow tie and Horizontal.

v. Now drag a video transitions and drop it
between the two clips or pictures over the
Storyboard.

4. Tt controls how your movie plays from one picture
to the next. You may also add a transition
between two pictures on the Storyboard/
Timeline.

A Video effect decides how a video clip, picture or
title gets displayed in your project.
B. Write T for the True statements and F for the

False ones:

1. F 2. T 3. T 4. T

C. Fill in the blanks with an appropriate
word:

1. play 2. full 3.storyboard, timeline



4.tasks 5. transition 6. collection

7. clips 8. story board 9. collection

10. pictures 11.video effect 12. monitor
D. Define the following terms:

1. Storyboard : Storyboard shows the sequence of
clips, whereas Timeline shows the timing of clips.

2. Timeline : Timeline displays your work in
progress.

3. Video effects : A video effect decides how a video
clip, picture or title gets displayed in your project.

4. Video transition : It controls how your movie
plays from one picture to the next. You may also
add a transition between two pictures on the

Storyboard/Timeline.
HOTS
Doit yourself
E.Match the following:
S.No. Task Shortcut keysin
Movie Maker
1. Createanew CTRL+N
project
2. Open an existing CTRL+I
project
3. Saveaproj CTRL+A
Save a project ALT+ENTER
new name
Save a movie CTRL+D
Import an exis{ing
clip CTRL+O




Select all clips CTRL+S

Play video in full
screen F12
9. Addselected clips
to the Storyboard/ CTRL+P
Timeline
Project
Doit yourself
I croote: - 20 I
In-text

Put a tick (v) for each of the correct statements
and a cross (X) for each of the incorrect ones.

(a) Parallel port is the slowest common transfer
method.v/

(b) Fire wireis an interface that is much faster than
USB 1.1 and compatible to USB 2.0.v

(c) A SCSI connection may transfer data at the
highest speed which both the controller and the
device support.v/

Exercise
A. Answer the following questions:
1. It shows that how the document will appear on the
paper.
2. It is an interface that is much faster than USB 1.1

and compatible to USB 2.0. Fire wire speeds are
25,50,100,400 and 800 megabytes/second.

3. Scanners may transfer data quickly and they are
easier to use and cheaper than SCSI devices. The
early USB 1.1 standard could transfer data at



only 1.5 megabytes/second, but the latter USB 2.0
standard transfers up to 60 megabytes/second
resulting in a faster operation.

4. A SCSI connection may transfer data at the
highest speed which both the controller and the
device support. It supports almost all computers

when you insert an SCSI interface card with the
PC.

5. The quality of a scanner depends on:

a. Pixels : It is made up of small squares
torepresent an image.

b. Resolution . Total number of pixels.

c. ColourDepth : The amount of information in
each pixel is known as colour
depth.

d. Density Range : The amount of space available

on a disk for recording images.

B. Write ( T) for each of the True statements and
(F) for each of the False ones:

1.F 2.T 3.T 4T 5F 6T 17.F
C.Fill up the blanks:
Pixel perinch
Dots perinch
Universal serial bus
Small computer system interface
Portrait, lands cape
Margins
Scanners

Device

S B A T o i

Fire wire
Flat bed

[t
e



HOTS

Do it yourself
D. Define the following terms:

1. Color depth : The amount of information in
each pixel is known as colour
depth.

2. Resolution : Total number of pixels.

3. Densityrange :The amount of space available on

adisk for recording images.

4. Pixel : It is made up of small squares to

represent an image.

E. Match the following:

®

A B

Parallel is the total number of pixels.

SCSI can transfer data up to 60
megabytes/second.

USB speeds are 25,50,100, 400 and
800 megabytes/ second.

Fire wire Ctrl+P.

Resolution made up of small squares.

Pixels stands for small computer
system interface.

Print is the slowest common trans-

B fer method.
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Multiple Choice Questions
Task-1

1.d, 2.a, 3.c, 4.b, 5.¢, 6.b, 7.,
8b, 9b, 10.b, 1l.c, 12.a, 13.b, 14.b,
15.a 16.¢ 17.a 18b 19.a 20.c¢c 21.b
22b 23.a 24.d 25.b 26.c 27.¢ 28b

29.a 30c 31b 3243

1.d, 2.a, 3.a, 4.b, 5.a, 6.d, 7.a,
8.d, 9., 10.b, 11.c, 12.d, 13.a,
14¢c. 15d 16.a 17.b 18.¢c 19.d



